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ABOUT THIS DOCUMENT

The Configuration Utility is used for configuring Honeywell software packages on Experion and non-
Honeywell nodes. The items that appear in the Configuration Utility's Configure menu depend upon
which Honeywell software packages have been installed on the node; therefore, not all sections in this
guide may apply to your site.

Beginning with Experion R431 and TPN R685, the Enhanced TPS Node (ETN) has been introduced.
In ETN, the LCNP4 card has been removed and is replaced by a combination of Enhanced TPS Node
Interface card (ETNI) and K4LCN board which provides the same functionality as the LCNP4 card.
Throughout the document, unless specifically mentioned, the term LCNP4 can be interchangeably
used with the terms ETNI-K4LCN hardware.

1.1 Revision history

Revision Date Description

A June 2021 Initial release of the document

1.2 References

The following list identifies documents that are sources of information for certain topics in this
publication.

Document title

System Management Configuration Guide

TPS File Transfer Installation and User’s Guide

GUS Display Builder User's Guide

GUS Remote Displays User's Guide

Native Window User's Guide
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GETTING STARTED

2.1 Using This Manual

The Configuration Utility is used for configuring Honeywell software packages on Experion PKS and
non- Honeywell nodes.

The items that appear in the Configuration Utility's Configure menu depend upon which Honeywell
software packages have been installed on the node; therefore, not all sections in this guide may apply
to your site.

To use this guide, go to the section describing the Configure menu item of interest.

2.2 Starting the Configuration Utility

2.2.1 Prerequisites

One of the following software components must be installed on a node that is used to start the
Configuration Utility:

Running multiple instances of the Configuration Utility can present inconsistent views of the
information and may cause problems. Similarly, the Configuration Utility should not be open while the
'Add/Remove Board' utility is being run.

2.2.2 Method 1 - Start the Configuration Utility

1. Log on to the node as the local Administrator or another user account that is a member of the local
Administrators group.

TIP

Use the Computer Management tool on the node to view the installed users and
groups.

2. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

3. Select Configure.

The Configure menu appears containing the 'pages' of the Configuration Utility available for the
local node.
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2.2.3 Method 2 -Start Configuration Utility from System Management
Display

If a Honeywell System Management Display has been created (using the Honeywell Node
Administration MMC snap- in), then you can use the following procedure to access a node's
Configuration Utility through the Honeywell System Management Display.

1. Select Start > All Programs > Honeywell Experion PKS > System Management > System
Management Display.

2. Select the previously configured console of interest: [console name].msc and respond to any
request for User Id and passwords.

3. Expand the hierarchy until you see the computer item of interest. Right-click the computer, and then
select Configure.

The Configure menu appears containing the 'pages' of the Configuration Utility available for the
selected node. The following Configure menu is an example for an ES-T node.

For detailed instructions on creating a Honeywell System Management Display, refer to the System
Management Configuration Guide.

Remote configuration through System Management Display

n The System Management Display supports remote (non- local) node configuration of the following items
in the Configuration Utility:

l Devices/Services

l SignOn Manager

l HCI Component

l HCI Name Service

2.2.4 Configuration Utility Menu Items

The items available in the Configuration Utility depend upon the software installed on the target node.
The remaining sections of this guide describe the selectable items in the Configure menu or refer to
other documentation.
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BOARD CONFIGURATION PAGES

3.1 Accessing the board configuration pages

The name of the node's local LCNP board appears as a menu item in the node's Configuration Utility
as 'Board0' (the default name) or as a customized name (for example, EST01). Selecting the menu item
invokes the ' Board Configuration Pages.'

3.1.1 Defining the LCNP Board Name for an ES-T/ESVT Node

Experion nodes have preconfigured personalities. The board name defaults to ' Board0'and under
normal conditions need not be changed.

3.1.2 Board Configuration Pages based on LCNP Personality

There are eight specific board configuration pages for each of the available LCNP board personalities
as shown in the following table.

ESVT and ACE-T uses the APP personality.

An ES-T uses the GUS personality.

Board Configuration Pages LCNP Personality

GUS US APP AM

1. LCNP X X X X

2. Common X X X X

3. Emulated Disks X X

4. Keyboard X X

5. Native Window X X

6. Printer X X

7. Data Access Configuration X X

8. TPN Time Sync X X

3.2 LCNP Page
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3.2.1 Usage of the LCNP Page

The LCNP Page is used for configuring an LCNP board that is running on a ES-T, Experion APP, US, or
AM.

3.2.2 Overview of the LCNP Page

The LCNP Page controls settings to configure LCN addressing, personality, and user access.

3.2.3 Accessing the LCNP Page
1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or

From the System Management Display, right - click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure >[LCNP board name]

Where [LCNP board name] is 'Board 0'(the default name) or a customized name.

3. Select the LCNP tab to display the following (ES-T example shown):

- 12 -
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ATTENTION

Beginning with Experion R500, for an Enhanced TPS Node, the following fields have
been modified on the LCNP (Board0) screen:

l the LCN Address field is disabled and users can only view the configured LCN
Address. The LCN Address is set on the K4LCN board using switches.

l the LCNP Auto Restart option is replaced with the K4LCN Auto Restart option, this
option provides automatic loading of K4LCN with LCN Node personality.

l the ETNI IP Address field specifies the IP address of the ETNI board to which the
ETN is paired. This field is only available in ETN.

ATTENTION

For an ETN-based PCUS Node, while configuring IP addresses for both ETNI processor
boards, enter unique IP addresses for ETNI Board 0 and ETNI Board 1, if not, the
Configuration Utility detects duplicate IP addresses and displays an error message as
shown in the following image.
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3.2.4 LCN address

The LCN Address field specifies the LCN address of the node.

The LCN Address appears in the LEDs field of the LCNP Status display. For the following example, ' 39'
was entered as the LCN Address:

The LCN Address also appears in the LEDs field of the LCN Native Window Status Bar. For the
following example, ' 2'was entered as the LCN Address:

For an Enhanced TPS Node, the LCN Address field has been disabled and users can only view the
configured LCN address. The LCN address is set on the K4LCN board using switches.

3.2.5 LCN name

LCNP Status and Native Window can be connected to the local LCNP board or to a PIN- connected

- 14 -
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LCNP board mounted in a GUS on another LCN. The LCN Name field helps the user identify which
LCN the LCNP Status and/or Native Window is connected to.

The LCN name is specified in the LCN Name field.

The LCN Name appears in the title bar of the LCNP Status display. For the following example, '
Rodgersberg Refinery' was entered as the LCN Name:

The LCN Name also appears in the title bar of the LCN Native Window. For the following example, '
Rodgersberg Refinery' was entered as the LCN Name:

3.2.6 NG Name

Data access is established through the Network Gateway's (NG) communication link to other LCNs.

The NG Name field specifies the two- letter name of the LCN's Network Gateway, if one exists.

The field should not be left blank. A space should be entered if the system does not have a Network
Gateway.

For an Enhanced TPS Node, type the pre-determined NG Name for the ETN-K4LCN Reset functionality
to work.

The NG Name appears in the title bar of the LCNP Status display. For the following example, ' FE' was
entered as the NG Name:

The NG Name also appears in the title bar of the LCN Native Window. For the following example, 'FE'
was entered as the NG Name:

3.2.7 Personality

This is the personality loaded through the Autoload Net command.

3.2.8 LCNP Reset Controls
Select the Local box to allow the LCNP to be reset from the local status display. Select the Remote box
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to allow the LCNP to be reset from the LCNP status display of a remote node.

On the LCNP Status display, the Reset LCNP button will be enabled as shown below.

ATTENTION

In the following LCNP Status display, the CNI slot cannot be seen because the TPS- SIM has not
been installed.

ATTENTION

Beginning with Experion R500, for an Enhanced TPS Node, the Reset LCNP button is replaced
with the Reset K4LCN button. This button performs a RESET on the K4LCN.

Following are the prerequisites for the K4LCN Reset functionality to work:

l The NG Name must be configured for all the nodes.

l All the nodes must be a part of a domain.

l Any other TPS Node in OK state in the same network must be running.

- 16 -
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Refer to the Reset LCNP Board section in the Native Window User's Guide for additional information.

3.2.9 Experion TPS System Alarm

Select the source for an Experion TPS System Alarm. (The default selection is Cluster Server Name and
the server name is automatically provided by the ES-T.). For new installs, the default selection is
<Disable>. Migrated systems may have to set the Experion TPS system alarm to Cluster Server Name. It
is recommended to disable the TPS system alarm and instead use the TPS System Status and TPS
Console Status indicators in the Experion Station status bar.

Computer Name

There is one TPS system alarm for each ES-T. Type the Computer Name in the<Source Name>.

LCN Name

LCN Name is a user-selected TPS system alarm source identifier to allow the aggregation of TPS
system alarms among a set of ES-Ts, based on configuration or operational considerations.

The Experion PKS System Alarm Summary Display shows a TPS system alarm per LCN Name. Type
the LCN Name in the <Source Name> space.

Cluster Server Name

Every ES-T in the Experion PKS cluster is configured for the Cluster Server Name as a default. If Cluster
Server Name is selected, there is only one TPS System Alarm on the Experion PKS System Alarm
Summary Display per cluster.
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<Disable>

You can disable the TPS system alarm for a node. It is recommended to use this setting for users
migrating to Experion R410.

TIP

The Experion TPS System Alarm is applicable only for ES-T nodes.

When a TPS System Alarm occurs, a Windows event occurs on each ES-T. The System Event
Server (SES) captures and converts this Windows event into an Experion PKS System Alarm, or
updates an existing alarm.

The selection of the option determines the source of the Experion TPS System Alarm and
specifies the name of the source.

3.2.10 TPN Time Sync Controls

LCNP4- GPS boards support a TPN time synchronization option that allows you to synchronize TPN
time to TPS time. An LCNP4-GPS board displays buttons in the details mode to adjust the time
synchronization. A node can leverage this Time sync capability only when configured as a Clock
Source in the NCF; other GPS enabled nodes become listener nodes. Once configured as a Clock
Source, enable and configure time sync on the clock source node.

Since GUS R330 and APP R211, the TPN Time Sync function provides the ability to synchronize TPN
time to TPS node time.

The TPN Time Sync controls on the LCNP Status Display are the Demand Time Sync button and the
Set TPN to TPS time button. The buttons are enabled only on the node that is designated as the Master
clock source.

The LCNP Status display also shows the current TPS and TPN times, and the time and result of the last
time- synchronization execution.

Beginning with Experion R500 and TPN R686, you can perform TPN time synchronization on an ETN
node.

The Primary and Secondary clock source nodes must have the LCNP4- GPS (or later) board installed.
During configuration of the System Wide Values in the Network Configuration File (NCF.CF), assign
CLOCK NODE 1 and CLOCK NODE 2 to the node numbers that have the LCNP4- GPS board installed.
The clock source node that has its personality loaded first becomes the Master clock source node.

Due to specific Microsoft time conversion routines used for daylight savings, TPN time may be incorrect
under the following conditions.

3.2.11 Demand Time Sync

Clicking on this button initiates a time sync analysis without waiting for the next time sync interval to
occur. It has the same effect as a configuration change in that whenever the configuration of the TPN
Time Sync function changes, TPN time synchronization is initiated. This button is functional when the
Enable TPS to TPN Time Synchronization function is selected on the Configure Board 0-TPN Time
Sync Page.

3.2.12 Set TPN to TPS Time

This button allows the user to synchronize TPN time to TPS time. The button is functional when the
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Time Sync checkbox is selected on the Configure Board 0-Common Page, and it is independent of the
Enable TPS to TPN Time Synchronization selection on the Configure Board 0-TPN Time Sync page. In
addition, the button is operational only when a user has signed onto the node using the Engineer
privilege.

When you click on the Set TPN to TPS time button, the following dialog box appears:

The warning message indicates that TPN time will be changed to TPS time immediately. Click OK to
accept the change or click Cancel to leave TPN time unchanged. When you click OK, TPN time is
immediately changed to TPS time. A Warning- Level event is logged on the System Event Log. This
option has the same effect as changing the TPN time manually.

CAUTION

When the user clicks OK, TPN time is set to the current TPS time.

The current TPS time may be slightly different that the time specified in the dialog pop-up
depending on when the last time update occurred.

3.2.13 TPS Time, TPN Time, and Time Synchronization Status

TPS time, TPN time, and Time Synchronization status are shown on the LCNP Status display as
described in the following listing:

If clock node type is… Then…

not an APP, GUS, or LCN- connected Experion node
with an LCNP4- GPS (or later) installed.

Current TPS time and ‘No Status Available’
are displayed.

a master clock source and the Time Sync is Not
Enabled.

Current TPS time and ‘Time Sync Not
Operational’ are displayed.

a master clock source and the Time Sync are Enabled. Current TPS time and TPN time are shown
with the last execution status.
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If clock node type is… Then…

a secondary clock source Current TPS time, TPN time, and clock
node type are displayed.

a listener (not a master or a secondary clock source) Current TPS time, TPN time, and clock
node type are displayed.

local node Current TPS time, TPN time, and clock
node type are displayed.

3.2.14 Last Execution Result

When the node is the Master clock node, the ' Last Execution Result' displays the results of the prior
TPN time sync operation as described in the following listing:

Results on the Master Clock Source node Diagram

No Action - Within Dead Band, TPN time was 17:33:21

Gradual Adjustment in Effect, TPN time was 09:59:08

Immediate Time Change Requested, TPN time was 09:45:29

No Action - Difference Exceeded Cutoff, TPN time was 00:00:37

3.2.15 Enable LCNP Auto Restart

The Enable LCNP Auto Restart box is unchecked by default. If the box is checked, then whenever the
LCNP goes into PWR_ON state, the LCNP is automatically loaded with the LCN Node personality using
the local personality image files from the local hard disk. After the personality image files are loaded,
the LCN files such as the NCF, area database, and backplane modules are loaded from the NET
(History Modules).

The LCNP Auto Restart feature is not applicable to Application Module Replacement and Universal
Station Replacement nodes.

- 20 -
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The Enable LCNP Auto Restart check box can be made available as a menu item in the Native Window
Access Menu. Refer to section Native Window Page.

Beginning with Experion R500, for an Enhanced TPS Node, the Enable LCNP Auto Restart option is
replaced with the Enable K4LCN Restart option. The information provided in this section also applies to
the K4LCN Auto Restart option.

CAUTION

When LCNP Auto Restart is enabled, any time the LCNP goes into PWR_ON state, the LCNP will
be automatically loaded. You will not be able to do a Local/Target load. You have to disable the
LCNP Auto Restart feature before you can load the node manually.

If nodes are to be restarted by the Automatic TPN System Restart function, then the LCNP Auto Restart
option for each node must be disabled in the respective Configuration Utility.

Related Scenarios

A list of six different scenarios related to the LCNP Auto Restart option follow.

Note: All scenarios, except the ones with Native Windows, also apply to LCN-connected Servers and
APP nodes; and the option will be loaded with APP Node personality.

Prerequisite

History modules containing files including the NCF, Area database, and backplane option files are
required.

Scenario 1: Experion Station - TPS is powered on/rebooted and required
History Module(s) are running

When a Experion Station - TPS is powered on or rebooted, the Windows operating system loads and
the LCNP goes into the PWR_ON state. If the LCNP Auto Restart option is enabled, a Experion Station
- TPS automatically loads the LCNP with the personality using files from the Experion Station - TPS
local hard disk, and then loads LCN files (including the NCF, area database files, and backplane
module files) from the History Module(s).

Scenario 2: Experion Station - TPS is powered on/rebooted and required
History Module(s) are not running

When a Experion Station - TPS is powered on or rebooted, the Windows operating system loads and
the LCNP goes into the PWR_ON State. If the LCNP Auto Restart option is enabled, the Experion
Station - TPS starts loading the files from the Experion Station - TPS local hard disk. If the system History
Module is not running, Experion Station - TPS fails after trying to open the NCF file for approximately 10
minutes. If the Backplane modules and the Area database files are not available during startup, the
Experion Station - TPS node displays a prompt (&CUS N, 1,2,3,4,X ? or AR0X N, 1,2,3,4,X ?
respectively) on its Native Window , if the Native Window is already running. If Native Window is
invoked AFTER the prompt is generated, the prompt will NOT show up in the Native Window, but the
personality will still be waiting for an input from the user. The node will be stalled in the READY state
until the user takes an action.

For an Experion APP or Experion server - TPS node, the LCNP stalls in the READY state until corrective
action is taken and the LCNP is reset.

When the required History Module starts running and the LCNP is reset to the PWR_ON state, the
LCNP is automatically loaded with the personality.
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Scenario 3: A Experion Station - TPS is shutdown and the required History
Module(s) are running

When a Experion Station - TPS is shutdown, the LCNP goes into the QUALIF state and LCNP Auto
Restart is not initiated. At this point, you must either load the personality manually or reset the LCNP to
the PWR_ON state so that the LCNP is automatically loaded with the personality.

Scenario 4: A failed Experion Station - TPS is being dumped

When a Experion Station - TPS is in the FAIL state and its memory is being dumped, the LCNP state
changes from the FAIL state to the PWR_ON state and the dump process starts. When the dump is
finished, if the LCNP Auto Restart option is enabled, the LCNP auto restart is initiated and the Experion
Station - TPS is automatically loaded with the personality.

Scenario 5: A failed Experion Station - TPS is being loaded

When a failed Experion Station - TPS node is being loaded from System Status Display of another
station, the LCNP state will transition from FAIL to PWR_ON state. If the LCNP auto restart is enabled,
LCNP auto restart is initiated and the LCNP will be automatically loaded with the personality. The target
load from the System Status Display will fail, because LCNP auto restart has taken over. If the LCNP
auto restart is enabled, you can reset the LCNP to the PWR_ON state and the LCNP will be
automatically loaded with the personality.

Scenario 6: Experion Station - TPS and History Module nodes are powered
on simultaneously

When the Experion Station - TPS and History Module nodes are powered on simultaneously, the
History Module is booted automatically and the LCNP goes into the PWR_ON state. At this point, if the
LCNP Auto Restart option is enabled, the LCNP starts loading the local QLTs and PI files and then tries
to open the NCF every 10 seconds for approximately 10 minutes (that is, 60 times in 10 minutes). If the
History Module is available and running in the span of 10 minutes, the LCNP will be loaded and put into
running state.

3.3 Common Page

3.3.1 Usage of Common Page

The Common Page is used for configuring an LCNP board running on Experion APP, ES-T, AM, or US.

3.3.2 Overview of the Common Page

The Common page is used to enable emulation service functions and to determine each function's
event log actions.

The default settings are correct for most sites. Do not change any setting without advice from Honeywell
personnel. Not all combinations of Common page settings result in usable systems, but Honeywell
special case recommendations will always result in viable combinations.
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3.3.3 Accessing the Common Page

1. For ES-T and Experion APP nodes, select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility.

2. Select Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Common tab to display information, similar to the following examples.

3.3.4 Common Page Example 1

The following Common Page example indicates that Honeywell Hi- Spec Solution's TPS- SIM software
is installed, due to the inclusion of the CNI slot and the exclusion of a PDG slot.

3.3.5 Common Page Example 2

The following Common Page is a ES-T example.
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The example indicates that Honeywell Hi- Spec Solution's TPS- SIM software is not installed, due to the
inclusion of the PDG slot and the exclusion of a CNI slot.

3.3.6 Setting Choices

Each one of the following settings determine one function event log action:

Setting Result

Error Only
(E)

Only function error messages will be written to the event log.

+ Warning
(EW)

Function error and warning messages will be written to the event log. This default
setting should be used for most installations. Do not change this setting without advice
from Honeywell personnel.

+
Information
(EWI)

Function error, warning, and information messages will be written to the event log.

+ Debug
(EWID)

Function error, warning, information, and debug messages will be written to the event
log.
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3.3.7 Common Page Setting Definitions

Setting Definition

LCNP
Interface

Connects an ES- T, ESVT, Experion APP, with the TPN.

PDG Slot
Emulation

Controls video, the keyboard, and the printer. It is required for US- type personalities.
Only available if Honeywell Hi- Spec Solutions TPS- SIM is not installed.

CNI Slot
Emulation

Contact Honeywell Hi- Spec Solutions for detailed information. Only available if
Honeywell Hi- Spec Solutions TPS- SIM is installed.

SCSI Slot
Emulation

Enables cartridge drive emulation. It is required for US- type personalities.

Work
Station
Interface
Emulation

Enables work station loads and TPN data access. It is required for, Experion APP, ES-T
and ESVT nodes.

Interface
Functions

Debug - Enables the low level TPS debugger. MMon - Supports proper synchronization
between the various TPS indicators (such as keyswitch) and the same indicators on the
ES-T. Debug and MMon should be enabled unless specifically advised otherwise by
Honeywell personnel. Time Sync - Time Sync option is selected by default indicating that
Time Sync function emulators are running. When the Time Sync is running it adds the
TPN Time Sync tab to the Configure- Board 0 pages.

PDG
Channels

KVP - Supports the keyboard, video, and pointer (mouse, trackball, or touch screen)
functions needed by US personalities. Printer - Enables printing. It is enabled by default
in order to support printing on a local or network printer. Only available if Honeywell Hi-
Spec Solutions TPS- SIM is NOT installed.

CNI
Channel
Groups

Contact Honeywell Hi- Spec Solutions for detailed information. Only available if
Honeywell Hi- Spec Solutions TPS- SIM is installed.

SCSI
Channels

Allows a US or ES- T to support emulated disk operation.

WSI
Channels

Contains the LCNP emulator This function should be enabled on all ES- T nodes unless
specifically advised otherwise by Honeywell personnel.

3.4 Data Access Configuration Page

3.4.1 Usage of the Configuration Page

The Data Access Configuration Page is used for configuring an LCNP board that is running on an
Experion APP or ES-T.

3.4.2 Overview of the Configuration Page

The settings on the Data Access Page determine the number of channels and servers that are reserved
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for High Priority Requests during node initialization.

3.4.3 Accessing the Configuration Page

1. For ES-T or Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility.

2. Select the following:

Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Data Access Configuration tab to display the following (ES-T example shown):

3.4.4 Setting the High Priority Channels

This configuration parameter allows you to configure the personality to set aside a defined number of
the data access channels for high priority actions only.
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The only contention for these channels will be between high priority data access applications.

Low priority data access applications will have to share the remaining channels with other low priority
data access applications and non- data access applications such as file transfer and journal access.

The following formula is used:

Number of Low Priority Channels = 20 - (Number of High Priority Channels)

After you have set the number of High Priority Channels, you can set the number of High Priority
Servers as shown below.

3.4.5 Setting the High Priority Servers

This configuration parameter allows you to configure the personality to set aside a defined number of
data access servers to service high priority requests only.

The following formula is used:

Number of Low Priority Servers = 6 - (Number of High Priority Servers)

Honeywell recommends that you do not set the number of high priority servers to 6. For more
information about the recommended settings on this page, refer to the 'Verifying Configuration of Board
0 Data Access Configuration and TPN Server Channels' in the Integrated Experion-TPS User's Guide

3.5 Emulated Disks Page

3.5.1 Usage of the Emulated Disks Page

The Emulated Disks Page is used for configuring an LCNP board that is running on a Experion Station -
TPS node.

3.5.2 Overview of the Emulated Disks Page

Emulated Disks provide cartridge drive functionality for Native Window by allocating Windows file space
for LCN file storage. Windows Emulated Disk files contain LCN directory structures and file information
stored in LCN file format.

Emulated disk files can be located:

l on a local or remote hard disk.

l on a local or remote CD- ROM.

Note that emulated disk files stored on tape must be copied to a hard disk or a CD- ROM to be usable.

Emulated disks are referenced by $Fnn drive numbers, where nn is one of the station's assigned
cartridge drive numbers as configured in the NCF for the station's LCN address.

With TPN R670, emulated disks can also be operated from the GUS/US using the TPN Command
Processor and EC files. For TPN R671 and greater, the emulated disks can also be operated from the
Experion Station- TPS.

Refer to Command Processor Operations Manual for more information about operating emulated disks
using the TPN/LCN Command Processor and EC files.
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3.5.3 Accessing the Emulated Disks Page

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Emulated Disks tab to display the following (ES-T example shown):

3.5.4 The Left Drive Field

The Left Drive emulator corresponds to the lower- numbered drive (as indicated for the node on the
Native Window Console Status display).

3.5.5 The Right Drive Field

The Right Drive emulator corresponds to the higher- numbered drive (as indicated for the node on the
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Native Window Console Status display).

3.5.6 The Dismount Buttons

Use the dismount buttons as follows to dismount an emulated disk:

It is imperative that emulated disks be dismounted after their use. Otherwise, a user in a following
session will not be able to mount the emulated disk, because the disk will still be flagged as being in
use by the prior user and therefore unavailable.

Click the Left Drive Dismount button if you wish to dismount the left emulated disk, or the Right Drive
Dismount button if you wish to dismount the right emulated disk.

You can also drag the disk to the Available (Dismounted) Emulated Disks list.

RESULT: The emulated disk is dismounted and it then appears in the Available (Dismounted)
Emulated Disks list.

3.5.7 The Available (Dismounted) Emulated Disks List

This field contains a listing of available local and remote emulated disk files that are located:

l on a local or remote hard disk.

l on a local or remote CD- ROM.

Note that files must be copied from a tape to a hard disk to be usable.

3.5.8 Locking options

With GUS R360, an emulated drive can be locked using the TPN Command Processor and EC files.
After an emulated disk is mounted, the emulated drive can be locked using the EDLOCK command.
Locking prevents dismounting of the emulated disk file. On the Emulated Disks page, a locked drive is
disabled for dismounting.
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You cannot dismount the emulated disk until you unlock the drive. You can unlock the drive using the
EDUNLOCK command.

Refer to Command Processor Operations, SW11 for more information about emulated disk commands.

Locked drives cannot be unlocked from the Emulated Disks page.

3.5.9 The Delete Button

If you want to delete a mounted disk, then follow the directions in the The Dismount Buttons section
before proceeding.

1. Select a dismounted emulated disk from the Available (Dismounted) Emulated Disks list.

2. Click Delete.

RESULT: The dialog 'Do you want to free the disk space?' appears.

3. Click Yes or No:

l Click yes to remove the emulated disk from the list and physically delete the file from its
storage location.

l Click No to remove the emulated disk from the Available (Dismounted) Emulated Disks list, but
not physically delete the file from its storage location.

3.5.10 The Properties Button

If you want to delete a mounted disk, then follow the directions in the The Dismount Buttons section
before proceeding.

1. Select a dismounted emulated disk from the Available (Dismounted) Emulated Disks list.
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2. Click Properties.

RESULT: The Emulated Disk Information dialog appears with the selected emulated disk file in the
Path field.

Size and Allocation are grayed out indicating that they cannot be changed.

TIP

Additional properties on emulated disks, such as date stamp and file permissions, can
be viewed by browsing to the file in Windows Explorer, right clicking the file, and
selecting 'Properties'.

3.5.11 The Refresh Button

The refresh button is used for refreshing the Available (Dismounted) Emulated Disks list.

3.5.12 The Mount Button

The emulated disk to be mounted must be included in the Available (Dismounted) Emulated Disks list.

If you wish to mount a disk in a drive that already has an emulated disk mounted, then follow the
instructions in The Dismount Buttons section before proceeding.

1. Select the available emulated disk to be mounted from the Available (Dismounted) Emulated Disks
list.

2. Click Mount and then select the drive that you wish to mount.

You can also drag an emulated disk from the available list to an open Left Drive or Right Drive field.

3.5.13 CD-RW Considerations

Special Considerations when using a CD-RW (re-writable CD) with emulated disk files:

3.5.14 The Set Path Button
With GUS R360, the TPN Command Processor and EC files use an emulated disk path to create,
mount, and delete emulated disks. This path can be configured using the Set Path button on the
Emulated Disks page. Honeywell strongly recommends you to use \Program
Data\Honeywell\EngineeringData\EmulatedDisks as the default emulated disk path.

Use the Set Path button as follows to configure the emulated disk path:
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1. Click Set Path.

RESULT: The Set Path dialog box appears.

2. Click Browse and then select a path for emulated disks.

OR

Enter the path. Honeywell strongly recommends you to use \Program
Data\Honeywell\EngineeringData\EmulatedDisks as the default emulated disk path.

ATTENTION

If you want to use a different directory, then restrict the access to the particular directory
to Honeywell users only.

ATTENTION

If you enter an invalid path, the following error message appears:

Click OK and enter the correct path.

3. Click OK.

3.5.15 The Create Button

The Create button is used for creating emulated disks on a local or remote GUS node.

Use the Create button as follows to create an emulated disk:

1. Click Create on the Emulated Disks dialog page.

RESULT: The Select Directory and File Name dialog box appears.
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Honeywell strongly recommends you to use \Program
Data\Honeywell\EngineeringData\EmulatedDisks as the default emulated disk path.

2. Select a drive and directory.

3. Enter a new filename.

4. Click OK.

5. RESULT: The Emulated Disk Information dialog appears.

6. Type in the maximum file size (in megabytes, not to exceed 500 Mb) in the Size field.

7. Select one of the Allocation radio buttons.

l Select Reserved to allocate the entire amount of file storage space. This space is reserved for
the file even if its size is less than the maximum file size. The amount of disk storage used does
not increase with the amount of data stored on the emulated disk.

l Select Dynamic to allocate a file storage space maximum. This allows the file to grow
dynamically. If the original file size is less than the allocated maximum file size, it uses only the
storage capacity required by the file. As the file size increases, so does the storage used until
the allocated maximum is reached.

8. Select one of the Access radio buttons:

l The Read Only button provides TPS access to your emulated disk and disallows user
changes.
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The Read Only choice would not make sense, since there is nothing written into the new file yet,
and it cannot be initialized or written to by the TPN if it has read- only access.

l Select Read/Write to provide TPN access to your emulated disk and allow user changes.

3.5.16 Making an Existing Local Emulated Disk Available for Mounting

1. Click Create on the Emulated Disks dialog page.

RESULT: The Select Directory and File Name dialog box appears.

2. Navigate to the folder that contains the existing local emulated disk file.

3. Select the existing local emulated disk file.

4. Click Open.

RESULT: The Emulated Disk Information dialog appears.

The settings shown are the disk files current settings.

5. Click OK.

RESULT: The local emulated disk file will now appear in the Available (Dismounted) Emulated
Disks list.
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3.5.17 Making an Existing Remote Emulated Disk Available for
Mounting

Incorrect registry edits WILL result in a non-operational node. Use extreme caution when editing the
registry on any node for any reason.

To create the share on the Remote Node

1. Log on to the remote node that hosts the emulated disk file as the local Administrator or a member
of the local Administrators group.

2. Create a directory that will only be used for remote emulated disk files.

3. Right-click the directory.

4. Select Properties.

5. Click the Sharing tab and select the Share this folder option.

6. Enter a Share Name.

7. Record the Share Name as you will use it later when you edit the registry on the remote node.

8. Enter the following Comment:

This folder should not contain any files except emulated disk files.

9. Click the Maximum Allowed radio button.

10. Click the Permissions button to display the Share Permissions.

11. Set the permissions as follows:

If the remote emulated disk file has read/write enabled, then grant Everyone the Full Control
permissions.

Otherwise, grant Everyone at least Read permission.

12. Click OK to close the Permissions dialog.

13. Copy the emulated disk file to the share that you just created.

14. Continue on to the section ' To set the Emulated Disk File Permissions on the Remote Node'.

To set the Emulated Disk File Permissions on the Remote Node

1. Right-click the emulated disk file located in the share.

2. Select Properties.

3. Click the Security tab.

RESULT: The share properties dialog box appears.

4. Set the permissions as follows:

If the remote emulated disk file has read/write enabled, then grant Everyone the Full Control
permission.

Otherwise, grant Everyone at least Read permission.

5. Click OK to close the File Permissions window.

6. Continue on to the section ' To edit the Registry on the Remote Node'.
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To edit the Registry on the Remote Node

1. Start REGEDIT32 on the remote node.

2. Locate the following registry key on the remote system:

\HKEY_LOCAL_MACHINE\SYSTEM

\CurrentControlSet\Services\LanmanServer\Parameters.

3. Double- click the NullSessionShares entry to display an editing box similar to the following:

4. Add an entry after the last entry that is identical to the name of the share that you created in the
above section. The following figure uses the 'ShareExample' example:

Be very careful not to delete any of the existing names. Also, be sure to press the Enter key after
you type in the share name so the cursor blinks below the new share name line. This is shown in
the above screen capture.

5. Click OK.

6. Exit REGEDT32.

7. Continue on to the section 'Connect the Local Node to the Remote Emulated Disk'.
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To connect the Local Node to the Remote Emulated Disk

1. Access the Emulated Disks page as described at the beginning of this section.

2. Click Create on the Emulated Disks dialog page.

RESULT: The Select Directory and File Name dialog box appears.

3. Navigate to the emulated disk file located in the remote share.

4. Click Open.

RESULT: The Emulated Disk Information dialog appears.

5. Click OK.

RESULT: The remote emulated disk file will now appear in the Available (Dismounted) Emulated
Disks list.

3.6 Keyboard Page
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3.6.1 Usage of the Keyboard Page

The Keyboard Page is used for configuring an LCNP board that is running on a Experion Station - TPS
node.

3.6.2 Overview of the Keyboard Page

The Keyboard Page enables a user to configure user- defined display keys and customize alarm
annunciation.

3.6.3 Key Action and Key Label Definition

There are six User Defined keys on the Operator keyboard. Because labels are area dependent, it is
recommended that you configure the six keys to have the same operation under all of the areas.

Programming the six User Defined keys entails two steps:

l First you define the Key Actions in Native Window (see the To define Key Actions section).

l Then you define the Key Titles using the Configuration Utility (see the To define Key Titles section.

TIP

On an Experion Station - TPS node, the key definition may be overridden by the Experion
Station. See the toolbars and buttons definition in Setting up Station in the Server and Client
Configuration Guide.

To define Key Actions

1. Choose Start > All Programs > Honeywell Experion PKS > TPS Applications > Native Windowfor
an Experion Station - TPS node.

2. Choose Displays > Engineering > Menu.

3. Click Button Configuration.

4. Enter the required key action.

For detailed key action information, refer to the TPN manual Implementation/Engineering
Operations- 1, Button Configuration Data Entry (PDF format).

5. Continue on to the To define Key Titles.

To define Key Titles

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
UtilityStarting the Configuration Utility.
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2. Select the following:

Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Keyboard tab to display the following (ES-T example shown):

4. Enter the titles for LCN user- configured buttons 1 - 6 in the Labels for User Defined Keys area of
the Keyboard page.

Be sure to enter the name of configured button 1 in User Defined position 1, configured button 2 in
User Defined position 2, and so on.

5. Do the following if you wish to customize the ALT key in a Native Window key combination:

Place an ampersand (&) in front of the mnemonic letter for the key title.

For example, if you entered O&RG SUMMARY on the Keyboard Page as a key label definition,
then you would press ALT- D- U- R in Native Window in order to display the Organizational
Summary Menu.

D is the mnemonic key for the Display menu,

U is the mnemonic key for the User Defined submenu, and

R is the mnemonic key for ORG SUMMARY in this example because of the ampersand location.

6. Click OK to complete the Key Title Definition.

- 39 -



3.6.4 Key Action Invocation Methods

Kbd / Program Key Action Invocation Method

Qwerty
Keyboard

Select Function Key 1 to 6.

ABC US
Keyboard

Select Function Key 1 to 6.

Integrated
Keyboard

Select one of the six buttons on the lower- left side of the Relegendable Operator
Control Panel.

Native Window
Menu

Select the key title defined using the 'Key Title Definition' section from the Displays >
User Defined Native Window menu.

3.6.5 Example Key Definition

The 'Key Action Definition' section is used to configure Button 1 as SCHEM ( 'MAIN MENU').

The 'Key Label Definition' section is used to define the Key 1 label as 'MAIN MENU'.

The user can now display the MAIN MENU schematic:

l by pressing Button 1 on the keyboard, or

l by selecting the Displays > User Defined > MAIN MENU item from within Native Window.

3.6.6 Annunciator Attributes

The Annunciator Attributes section of the Keyboard dialog page provides the opportunity to annunciate
alarms through the workstation speaker when an Integrated Keyboard is NOT present.

TIP

On an Experion Station - TPS node, annunciation attributes are disregarded and should be left
disabled. Annunciation is under the control of the Experion Station. See Alarm Annunciation in
the Server and Client Planning Guide.

Customize alarm sound characteristics for each alarm contact number.

Contact #

Through the NCF System Wide Values configuration, LCN alarm annunciation events (including
emergency, high, and low priority alarms) can be set to correspond to contact numbers 1, 2, or 3. For
example, if you want emergency priority alarms to close contact 3, select Contact 3 in the NCF
configuration.

Pitch

Select high, medium, or low from the Pitch field selections to set a different alarm pitch for each
annunciated alarm priority.
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Duration

Select short, medium, or long from the Duration field selections to choose how long the alarm sound
continues for each annunciated alarm priority.

Repeat Rate

Select fast, medium, or slow from the Repeat Rate field selections to choose how often the alarm
repeats for each annunciated alarm priority.

Enabled Checkbox

Check the Enabled box to enable the respective alarm contact.

Test buttons

Click Test to hear an enabled alarm contact's annunciation settings.

Settings button

Click Settings to display the Annunciator Settings dialog box. The default settings are given in the
following table.

Pitch (Hertz) Duration (Msec) Repeat Rate (Msec)

High 400 Short 100 Fast 100

Medium 300 Medium 300 Medium 400

Low 100 Long 500 Slow 700

Annunciator Defaults

Contact # Pitch Duration Repeat Rate Enabled

3 High Short Fast X

2 Medium Medium Medium X

1 Low Long Slow X

3.7 Native Window Page

3.7.1 Usage of the Native Window Page

The Native Window Page is used for configuring the Native Window options for an LCNP board that is
running on a Experion Station - TPS node.
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3.7.2 Overivew of the Native Window Page

The Native Window Page is used for controlling the operation of the Native Window application.

3.7.3 Accessing the Native Window Page
1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
UtilityStarting the Configuration Utility.

2. Select the following:

Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Native Window tab to display the following (ES-T example shown):
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ATTENTION

Beginning with Experion R500, for an Enhanced TPS Node, the LCNP Auto Restart
option is replaced with the K4LCN Auto Restart option and the LCNP Reset Enables
option is replaced with the K4LCN Reset Enables option.

Following are the prerequisites for the K4LCN Reset functionality to work:

l The NG Name must be configured for all the nodes.

l All the nodes must be a part of a domain.

l Any other TPS Node in OK state in the same network must be running.

3.7.4 Connection Controls

The following table defines the selectable options for Connection Controls appearing on the Native
Window page.

Option Usage Default Setting /
Recommendation

Enable Local
Connections

Check this box to enable Native Window connection to
the local LCNP board by local users.

Checked by default. It is
recommended that this box
be checked on all node
types.

Enable
Remote
Connections

Check this box to enable Native Window connection to
the local LCNP board by remote users.

Unchecked by default.
Check, this box if the TPS
Administrator wants remote
access.

Enable Local Check this box to enable the ability to override a remote Checked by default. It is
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Option Usage Default Setting /
Recommendation

Connection
Override

user's Native Window connection when a local user
Native Window connection is requested. The local user
is notified that the Native Window is in use by another
user (user is identified) and is warned that the remote
user will be disconnected. If the local user overrides the
connection, the remote user is disconnected and is
informed that the connection was terminated.

recommended that this box
be checked on all node
types.

Allow
Disconnect

Check the box to allow any user account to disconnect a
local or remote Native Window connection. Note that if
Native Window becomes disconnected, the user will be
still allowed to reconnect regardless of the box setting.

Checked by default. Check
this box if the disconnect
option is desired by the
TPS Administrator.

Confirm
Disconnects

Check this box if you want users to confirm all
disconnects of the Native Window.

Checked by default. It is
recommended that this box
be checked on all node
types.

Clear
Display on
Disconnect

Check this box to clear the Native Window client area
when it is disconnected. Otherwise, the display shown
prior to disconnect is retained.

Checked by default. It is
recommended that this box
be checked on all node
types.

IKB/OEP
Annunciation

This checkbox is only visible on ES- T nodes. Check this
box to have the TPN supply the IKB/OEP commands
directly to the IKB Service.

The Experion station
services the IEK/OEP
commands first if it is
running, regardless of the
selection of this check box.
If Experion software Is not
installed, then the
checkbox is checked and
disabled (grey).

3.7.5 Mouse Button Function Selection

The following mouse button options apply only during Native window operation.

Function Button Default Resulting Button Action

Select Default setting for the
left mouse button.

A screen touch message is sent to the TPN personality when the
mouse button is clicked. This option may be chosen for only one of
the mouse buttons at any one time.

None Default setting for the
middle mouse button.

No action occurs when the mouse button is clicked. This option
may be selected for any combination of the mouse buttons.

Menu Default setting for the
right mouse button.

A context menu is shown at the cursor location when the mouse
button is clicked. This option may be chosen for only one of the
mouse buttons at any one time.

Enter This is not a default
setting for any of the
mouse buttons.

The equivalent action to pressing the enter key occurs when the
mouse button is clicked. This option may be chosen for only one of
the mouse buttons at any one time.

3.7.6 LCNP Auto Restart
The Enable LCNP Native Window Auto Restart Menu Item box in the Configuration
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Utility>Configure>Board 0>Native Window is unchecked by default. When checked, a menu item LCNP
Auto Restart is selectable in the Access menu of the Native window. LCNP Auto Restart menu item is
not key locked. By selecting the LCNP Auto Restart menu item, the Native window user can
enable/disable the LCNP auto restart feature, thus toggling the state of the Enable LCNP Auto Restart
checkbox (on LCNP tab). A checkmark corresponding to the menu item LCNP Auto Restart indicates
that the LCNP auto restart feature is enabled.

Scenario

If Configuration Utility>Configure- >Board 0- >Native Window>Enable LCNP Auto RestartMenu Item is
enabled and either the Configuration Utility>Configure>Board 0>LCNP>Enable LCNP Auto Restartor
Native Window>Access>LCNP Auto Restartis enabled.

When a ES-T node is powered on or rebooted, the Windows operating system is loaded. If the LCNP
Auto Restart or Configuration Utility>Configure- >Board 0>LCNP>Enable LCNP Auto Restart menu
item is unchecked, the user has to manually load the Native Window. As soon as the LCNP Auto
Restart is enabled and a RESET is initiated to the LCNP, a power on, or a reboot of the node, the LCNP
'Native Window' is automatically loaded with the personality.

CAUTION

When LCNP Auto Restart is enabled, any time the LCNP goes into PWR_ON state, the LCNP
will be automatically loaded. You will not be able to do a Local/Target load. You have to disable
the LCNP Auto Restart feature before you can load the node manually (Local/Target).

ATTENTION

Before performing a memory dump, you must insure that the Auto Restart menu item is not
selected. If the Auto Restart menu item is selected, the LCNP will try to restart during a memory
dump, canceling the dump.

You can also uncheck the Enable Native Window Auto Restart menu box within the
Configuration Utility to disable Auto Restart.

ATTENTION

Beginning with Experion R500, for an Enhanced TPS Node, the following changes have been
made on the user interfaces.
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l On the LCNP Status Display, the Reset LCNP button is replaced with the Reset K4LCN
button.

l On the LCNP (Board0) display, the Enable LCNP Auto Restart option is replaced with
the Enable K4LCN Auto Restart option.
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Following are the prerequisites for the K4LCN Reset functionality to work:

l The NG Name must be configured for all the nodes.

l All the nodes must be a part of a domain.

l Any other TPS Node in OK state in the same network must be running.

3.7.7 Access Menu in the Native Window
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ATTENTION

Beginning with Experion R500 and TPN R686, on the Access menu item in Native Window, the
Reset LCNP Board... option is replaced with the Reset K4LCN... option and the LCNP Auto
Restart option is replaced with the Enable K4LCN Auto Restart option.

3.7.8 LCNP Reset Enables

l Local: Allows the LCNP board to be reset from the local Native Window or Emulators Status display.
The default setting is unchecked.

l Remote: Allows the LCNP board to be reset from a remote Native Window or Emulators Status
display. The default setting is unchecked.

Refer to the 'Reset LCNP Board' section in the Native Window User's Guide for additional information.

3.7.9 Print Trend

Disable Print Trend

Check this box to disable the Print Trend function. The default setting is unchecked (Print Trend function
is enabled).

When this box is checked, the PRINT TREND function is disabled in the FILE MENU and the HISTORY
MENU of the Native Window. In addition, the PRINT TREND key on the IKB (Integrated Keyboard) also
is disabled.

3.7.10 Native Window Appearance

Maintain 1:1 Aspect Ratio Option

Check this box and characters and objects will appear with coordinated, proportional heights and
widths.

The default setting is checked and this is the recommendation for all node types.

Font Smoothing Option

Check this box to enable font smoothing on ES- T startup. When the Native Window is called up, the
display appears with smoother characters at all window sizes.
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If the font smoothing setting in Configuration Utility is changed during Native Window operation,
changes will take effect only after the Native Window has been disconnected and reconnected.

Fonts used by the Native Window may be specified in the Configuration Utility's LCNI18N property
page. Users may specify any font currently installed on the ES-T system; however, only non-
proportional fonts (every character is the same width) work properly in Native Window. Font smoothing
is most effective with True- Type fonts, particularly Courier New. The default fonts (lcn8x16_0 and
lcn8x8_0) are raster, not True- Type, fonts.

The default setting is checked and this is the recommendation for all node types.

For examples of font smoothing, refer to the 'Font Smoothing' section in the Native Window User's Guide

Full Screen Option

Check this option to display Native Window on the full screen after connection. This is a connection-
time action only. The user is allowed to make Native Window non- full- screen after connect, unless the
Menu Bar is also hidden. Refer to the following section, Show Menu/Title Bars Option, for information. If
the menu bar is configured as hidden, and Full Screen is enabled, the Native Window will remain full
screen until it is shut down or disconnected.

The default setting is unchecked. It is recommended that the box be checked for US Replacement
nodes.

Show Menu/Title Bars Option

Check this option and the menu and title bars will be visible at connect time.

Uncheck this option and the right mouse button menu option to make them visible will be grayed. The
menu bar will therefore be inaccessible until the box is checked, and Native Window is disconnected
and reconnected, or shut down and restarted.

The default setting is checked. It is recommended that the box be checked for ES- T nodes. The setting
is the choice of theProduct Administrator on US Replacement nodes.

Show Status Bar Option

Check this option and the status bar will be visible at connect time. Uncheck this option and the right
mouse button menu option to make the status bar visible will be grayed. The status bar will therefore be
inaccessible until the box is checked. The default setting is checked. It is recommended that the box be
checked for Experion Station - TPS nodes. The setting is the choice of the Product Administrator on US
Replacement nodes.

3.7.11 IKB/OEP Annunciation selections

The Board Configuration Page displays selections for IKB/OEP annunciation. The 'TPN - in absence of
Experion' setting appears for Experion nodes and does not appear for a GUS node.
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Set to Engineer Menu on close

When checked, closing the Native Window sets the emulators to the Engineering Main menu and
suppresses IKB alarm annunciation.

TPN - in absence of Experion

The setting appears when using Experion nodes, such as the Experion Station - TPS and Native
Window only Experion node. Choosing the setting depends on the Experion node type, its intended
use, and availability of Experion Station functionality.

If an Experion Station with TPS options node (for example, an Experion Station - TPS or ES- CE), then
uncheck so Experion events can annunciate from the IKB/OEP.

If a Native window only, Experion ready node (that is, the node does not have Experion Station
functionality available), then check so TPN events can annunciate from the IKB/OEP.

3.7.12 Experion Processing of IKB/OEP Keys

With Experion R400, operators can invoke Experion Detail, Group, Trend, and Group History displays
directly from the Native Window or GUS displays, associated with any point in the change zone for the
active Native Window or GUS display. For example, consider the point A100 is displayed in the Native
Window change zone. If you press the IKB Detail key while the Native Window is the active display, the
Experion detail display for A100 is invoked. Similarly, an Experion Group, Trend, or Group History
display is invoked for the point A100 by pressing the Group, Trend or Hour Avg IKB key, if the change
zone point is configured in an Experion group or trend. If a change zone point is not configured in an
Experion group or trend, then the operator is prompted for Experion group/group history or trend
number to invoke.

If there is no change zone point selected in the active Native Window or GUS display, then Experion
prompts for a detail point or group/group history or trend number to invoke. This behavior occurs for
Detail, Group, Trend/Hour Avg IKB key presses only if their respective checkbox is selected in the
Experion Processing of IKB/OEP Keys area of the NativeWindow configuration page. Note that Trend
and Hour Avg IKB keys share the 'Trend' checkbox on the Native Window configuration page.

When the options are selected, Experion processes the keys in the following sequence.

l A change zone point is searched in the active NW/GUS display; if found, then that point is used for
invoking the associated Experion display, unless no group/trend configured for that point.

l If a point is not found, or no group/trend configured for the change zone point, the system prompts
for a point to invoke the Detail display, or a number to invoke the Trend/Group History/Group
display.

When the options are not selected, the pressing of the IKB key is allowed to be processed by the Native
Window if it is the active display, or by GUS, if it is the active display.
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l If the Native Window is the active display, then the Native Window processes the key directly. For
example, if the Detail option is cleared, then the Native Window may prompt for the detail to invoke
in the Native Window.

l If the GUS display is the active display and the display is configured to process the key (for example,
'OnDetail page script implemented') then the GUS display processes the key. Otherwise, Experion
prompts for a point to invoke the Detail display, or a number to invoke the Trend/Group
History/Group display.

By default, the Detail and Group options are selected. The Trend option is cleared to maintain
consistency with pre-R400 behavior, which allows for the Native Window to process the Trend key
when the Native Window is the active display.

3.8 Printer Page

3.8.1 Usage of the Printer Page

The Printer Page is used for configuring an LCNP board that is running on a US or Experion Station -
TPS node.

3.8.2 Overview of the Printer Page

The Printer Page settings allow you to configure printer, printer font and size, and real- time journal
printing intervals.

For detailed instructions to configure the printer, refer to the subsection ' Configuring LCNP (Board 0)
Settings' in the TPS System Implementation Guide.

3.8.3 Accessing the Printer Page

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
UtilityStarting the Configuration Utility.

2. Select the following:

Configure > [LCNP board name]

Where [LCNP board name] is 'Board 0' (the default name) or a customized name.

3. Select the Printer tab to display the following (ES-T example shown):
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3.8.4 Printer Selection

The three printer configuration choices are described below:

l If the node will not connect to a printer, select the No Printer Selected radio button. Select this
mode if the printer function of the Universal Station is not to be used. If this mode is selected and
the TPN NCF has a printer configured for the node, then the Console Status display will indicate
that the printer for this node is off- line.

l If the node will connect to a shared printer, select the Batch Printer Selection radio button. This
mode allows selection of local or remote printers, and allows the selected printer to be shared with
other applications and/or other nodes. Printed output from the station is collected until the
configured time or line limit is reached, and printed as a 'batch'. In this mode, the true status of the
printer is hidden by the Windows operating system, and will most often show as OK on the Native
Window Console Status display, even when the printer is off- line or absent.

l If the node will connect to a dedicated printer, select the Continuous Printer Selection option
button. This mode most closely emulates the printing behavior of the LCN Universal Station. In this
mode, print output from the station is sent immediately to the printer, which is useful for printing
alarms. The printer must be connected to a serial port of this node, and it may not be used across
the network or shared with any other application on the connected node or on any other node. With
TPS R360, the printer can be connected to an USB port.
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To configure a dedicated printer to a serial/parallel/USB printer

1. Select the Continuous Printer Selection radio button. The following two options are available in the
Model field:

l ASPI Serial Printer

l Generic Parallel Printer

2. Select ASPI Serial Printer as the Model to display the following:

Note: Some print filters may display a Protocol field. If so, set that selection to match the
configuration of the printer.

3. Select the correct Port for the printer.

Note: If the printer is currently configured as a shared Windows printer, then the printer's port will
not be selectable. Use the Printer Control Panel to de-configure the printer, so it can be used as a
continuous mode printer.

4. Click OK to complete LCNP board configuration. OR

5. Select the Generic Parallel Printer as the Model to display the following:
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6. Select the correct Port for the printer.

7. Click OK to complete LCNP board configuration.

3.8.5 Printing a Real Time Journal (RTJ) from the Native Window

The letters RTJ appear in a pane in the Native Window status bar when a Batch Printer Selection is
configured and there are events in the real- time journal queue that can be demand printed. You can
print those event messages on demand or wait until one of the two criteria, Idle Flush Time or Queue
Length, is met. If either no printer or a continuous mode printer is configured, the RTJ pane will never be
enabled.

To demand print from the Native Window, select Print RTJ from the File menu.

You may also click the RTJ pane on the status bar shown below:

3.8.6 Printing the RTJ to a file

As an alternative to line- by- line printing, you may specify a pathname for periodic printing of the RTJ to
a file. After clicking RTJ:
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l Select InputFileName.

l Click Browse and navigate to an appropriate file location.

3.8.7 Configuring a Batch Printer as a Virtual Printer in Microsoft
Windows 7 or later

When the current default printer is a virtual printer, such as PDF or Microsoft XPS Document Writer,
Batch Print will not print, and the following error message is displayed on the Native window.

HARDWARE DEVICE TIMEOUT (7)

Batch Print is currently not designed to handle virtual printers on Microsoft Windows 7-based ES-T
nodes compared to Microsoft XP-based GUS stations.

Due to improved security on Microsoft Windows 7 or later, Microsoft Windows services run in Session 0
isolation including the "TDC Emulators service" which is responsible for emulating TPS functionalities in
Microsoft Windows. TDC service in session 0 having problems to interact with users running in other
sessions can result in print operations failure.

If you configure a virtual printer (PDF/XPS printer), then for every print operation, a new file will be
created (.pdf/.xps) and will prompt to select a location for saving the file.

To use a virtual printer in Microsoft Windows 7 or later, perform the following procedure.

1. From the Start menu, click Devices and Printers.

2. Click Add Printer. A pop-up window appears.

3. At the bottom of the window, click The printer that I want isn't listed.

4. Choose Add a local printer or network printer with manual settings.

5. Click Create a new port, and then click Local Port next to Type of Port.

6. In the Port Name dialog box, type the path and file name as shown in the following examples:

For Microsoft XPS Document Writer - "C:\Temp\PrintJob.oxps"

For Microsoft Print to PDF - "C:\Temp\PrintJob.pdf”

7. Click Next.

8. Select Microsoft from the Manufacturer drop-down list.

9. Select Microsoft Print to PDF or Microsoft XPS Document Writer from the Printers drop-down list.

10. Click OK to close the dialog box.

11. Open the LCN Print Setup page through Configuration Utility or Native Window.

12. In the Printer tab, select the Batch Printer Selection option and click Print Setup.
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l For Microsoft Print to PDF:
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l For Microsoft XPS Document Writer:

13. From the Native Window, go to Engineering Menu > Command Processor and initiate a print job.

Note: If the file is already created, it will overwrite the existing file. Make sure to save or backup old
data or file before giving a new or next print command.

3.9 TPN Time Sync Page

3.9.1 Usage of the TPN Time Sync Page

The TPN Time Sync dialog page allows you to configure values required for synchronizing TPN time to
TPS time. This function is available only if the Time Sync option is enabled on the Common page. TPN
Time Sync can be implemented in Experion nodes and systems that are at the following minimum
release levels: GUS R330 and APP R211.

Verify that LCNP4- GPS boards are installed in Experion nodes that have been designated as CLOCK
NODE 1 and CLOCK NODE 2 clock sources in the NCF.CF file.
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3.9.2 Overview of the TPN Time Sync Page

The TPN Time Sync page allows you to:

l Enable Auto Adjust for Daylight Savings.

l Enable TPS to TPN Time Synchronization, including specifying the Synchronization Interval and
Dead Band Limit.

l Enable Gradual Adjustment, including the Gradual Adjust Limit and the Cutoff Synchronization
Limit.

3.9.3 Accessing the TPN Time Sync Page

1. Select Board n (n = board number) from the Configure drop-down menu.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the TPN Time Sync tab to display the following:

Any change to a TPN Time Synchronization configuration setting will execute the function
immediately based on the new configuration settings, and continue on a periodic basis as
configured in the synchronization interval.
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3.9.4 Enable Auto Adjust for Daylight Savings

If selected, TPN time will automatically be adjusted to Daylight Savings Time (DST). This change is
immediate even if the Enable Gradual Adjustment option is selected. The change of the DST setting is
an abrupt change and may cause loss of history data based on CLOCK NODE 1 being set backward or
forward. The DST adjustment occurs when Windows Date/Time properties initiates a DST change.

When a DST change occurs at CLOCK NODE 1, the node immediately changes the TPN time to the
TPS time and eliminates any gradual adjustment that was in effect.

During this process, the Enable Gradual Adjustment option will be ineffective even if it is checked.

If the Enable Auto Adjust for Daylight Savings option is not selected and a DST event occurs, the Time
Sync function will continue to synchronize the TPN time at a fixed offset value that is equal to the DST
adjustment value configured in Windows Date/Time properties.

This fixed offset value remains in effect until the user clicks on the Set TPN to TPS time button on the
LCNP Status display, or the TPN Time Sync function detects a change in the TPN time that is
approximately equal to the DST adjustment, as configured in the Windows Date/Time properties. The
difference in time must be within 5 minutes of the DST adjustment value.

The Enable Auto Adjust for Daylight Savings selection is independent of the Enable TPS to TPN Time
Synchronization checkbox.

3.9.5 Enable TPS to TPN Time Synchronization

If selected and this node is CLOCK NODE 1, TPN and TPS times will be checked at the time interval
specified in the Synchronization Intervaloption. If there is a discrepancy between TPN and TPS times
that is greater than the Dead Band Limit, TPN time will be adjusted to TPS time according to the
adjustment options selected. By default, the Enable TPS to TPN Time Synchronization box is
unchecked.

With TPS R420, the time synchronization is enabled when the TPN node is a Master clock node and the
option for time synchronization is selected. For example, in a TPS domain, (which includes
GUS/APP/EST/ESVT/ACET and a Domain Controller), all the Windows nodes are configured to get the
time from the Domain Controller.

If one of the T-nodes is made as a TPN Clock Master and the time synchronization is enabled, then all
the TPN nodes will listen to the T-node.

If the Clock Mastership is switched to another TPN node, then the time synchronization to the T-node
does not happen. As a result, the Windows nodes and the TPN nodes do not follow the same time
source. All the Windows nodes will continue to follow the Domain Controller and all the TPN nodes will
listen to the new Master.

Synchronization Interval Setting

This setting is the amount of time (in seconds) between comparisons of TPN and TPS times. You can
enter the Synchronization Interval in seconds when Enable TPS to TPN Time Synchronization is
selected. When CLOCK NODE 1 is loaded with its personality, then the time correction calculation
occurs at the interval specified in Synchronization Interval. The configurable adjustment range is 1-
99999 seconds, and the default value is set at 3600 seconds (1 hr). During this time interval, if the time
difference exceeds the Dead Band Limit, the Master clock node starts adjusting TPN time gradually to
synchronize it with TPS time.

If the time difference exceeds the Cutoff Synchronization Limit value, the time difference should be
reduced manually by one of the following methods:

- 59 -



l Changing the time abruptly through the Set TPN to TPS Time button on the LCNP Status display
of CLOCK NODE 1 to reactivate the time synchronization mechanism.

l Changing the time abruptly by changing the TPN time using the Native Window targets so that the
time is within the cutoff value. The next scheduled execution of the TPN Time Sync function will
adjust the TPN time to be closer to the TPS time.

The user must have Engineer keylevel access to perform the task.

Dead Band Limit Setting

If the difference between TPN time and TPS time falls within the specified Dead Band Limit (1- 10
seconds), then no action will be taken by the Time Synchronization function. An exception is when the
difference is within the dead band and gradual adjustment is in effect, then gradual adjustment will
continue when possible to further reduce the time difference. The default value for the Dead Band Limit
is 2 seconds. The Dead Band Limit value cannot be greater than the Gradual Adjust Limit value (when
Enable Gradual Adjustment has been selected) or the Cutoff Synchronization Limit value (when
Enable Gradual Adjustment has not been selected).

If the difference between TPN time and TPS time exceeds the Dead Band Limit, then the function will
initiate a gradual adjustment as specified by the Enable Gradual Adjustment settings.

3.9.6 Enable Gradual Adjustment

If selected, adjustments to the TPN time will be made gradually according to the time specified by the
Gradual Adjust Limit (Sec) value. It is recommended that this option be selected to avoid loss of
historized data. If the Enable Gradual Adjustment box is unchecked, then the time changes will occur
immediately.

Gradual adjustment is possible only if the CLOCK NODE 1 / CLOCK NODE 2 TPS nodes have the
LCNP4- GPS board installed.

Gradual Adjust Limit Setting

This option is in effect when the time difference between the TPS time and TPN time exceeds the Dead
Band Limitvalue but is less than the Gradual Adjust Limit value. An exception is when the difference is
within the dead band when gradual adjustment is already in effect, then gradual adjustment will
continue when possible to further reduce the time difference. The range of the Gradual Adjust Limit
value is 1- 99999 seconds. The default value for this option is 10 seconds.

The Gradual Adjust Limit value cannot be less than the Dead Band Limit value, and cannot be greater
than the Cutoff Synchronization Limit.

Cutoff Synchronization Limit Setting

Time adjustments are not made if the time difference between TPN and TPS nodes exceeds the Cutoff
Synchronization Limit value. The value range is 1- 99999 seconds. By default, the Cutoff
Synchronization Limit is set to 99999 seconds (27.5 hours). The Cutoff Synchronization Limit cannot
be less than the Gradual Adjust Limit or the Dead Band Limit.

If the time difference exceeds the Cutoff Synchronization Limit value, the time difference should be
reduced manually by one of the following methods:
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l Changing the time abruptly through the Set TPN to TPS Time button on the LCNP Status display of
CLOCK NODE 1 to reactivate the time synchronization mechanism.

l Changing the time abruptly by changing the TPN time using the Native Window targets so that the
time is within the cutoff value. The next scheduled execution of the TPN Time Sync function will
adjust the TPN time to be closer to the TPS time.

The user must have Engineer keylevel access to perform the task.

After you enter the TPN Time Sync values in the CLOCK NODE 1 source, ensure that you enter the
same values in the TPN Time Sync page of the CLOCK NODE 2 source.
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DEVICES/SERVICES PAGE

4.1 Overview of the Devices/Services Page

The Devices/Services Page is used for configuring the automatic startup of Device Drivers and
Services.

The default settings for the services and drivers are configured by the installation program.

4.2 Accessing the Devices/Services Page

1. Select the following to start the Configuration Utility.

Start > All Programs > Honeywell Experion PKS > System Management Configuration Utility.

Or

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure>Devices/Services.

RESULT: The following is displayed.
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4.3 TPS Admin and Operator Signon Options

TPS Signon Manager
service

Select this box unless you are instructed by Honeywell to do
otherwise.

4.4 LCNP Device Driver and Emulation Services Options

Device Driver
(tdcaint.sys)

Select this box (if it is available) unless you are instructed by Honeywell to
do otherwise.

Services (Tdcaserver) Select this box (if it is available) unless you are instructed by Honeywell to
do otherwise.

4.5 Time Synchronization Service Options

This optional function periodically sets the time to LCN time.

- 63 -

Chapter 4 - Devices/Services Page



Chapter 4 - Devices/Services Page

Clear this box (if it is available) unless you are instructed by Honeywell to do otherwise.

4.6 Additional Software Services Options

GUSRemote
LXS

For TPS GUS and Network GUS nodes, this box is checked only if the GUS Remote
Displays Server package has been installed. This box is grayed out unless the
GUS Remote Displays Server package has been installed. The box is grayed out
for the following nodes:

l AM Replacement nodes

l APP nodes

l Standalone GUS nodes

l US Replacement nodes

TPN
Communication
Service

With TPS R410, this option is used for running or stopping TPN Communication
Service.

4.7 Optional Hardware Devices Options

Integrated Keyboard
Driver

This box is selected for Experion Station - TPS with either of the
following:

l Integrated Keyboard option

l Operator Entry Panel option on a Honeywell Icon Series Console
This box is shaded on Experion APP and AM Replacement nodes.
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FILE TRANSFER PAGES

5.1 Reference to Other Documentation

For information on the GUS Remote Displays Client Page of the Configuration Utility, refer to the GUS
Remote Displays User's Guide.
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TPN COMMUNICATION SERVICE

6.1 Overview of the TPN Communication Service Page

With TPS R410, TPN Communication Service facilitates TPS-TPN status communication. This option is
used for running or stopping TPN Communication Service. On the Devices/Services page, this option
is selected by default. The HCI component composite state of the TPS node is propagated optionally
when the HCI components fail.

6.2 Accessing the TPN Communication Service Page

1. Open the Configuration Utility as follows:

Start > All Programs > Honeywell Experion PKS > System Management > Configuration Utility.

ATTENTION

Running TPN Communication Service is mandatory for monitoring the HCI
components from TPN.

The HCI component composite state of the TPS node is communicated to TPN through
this service. The composite HCI status is reflected in the auxiliary status of the node.

RESULT: The following screen is displayed.

2. Choose Configure > TPN Communication Service.

RESULT: On clicking TPN Communication Service, the following dialog box is displayed.
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3. To enable or disable the HCI State Notification, select or clear the check box provided on the TPN
Communication Service screen.

ATTENTION

With the TPN Communication Service running, when the HCI State Notification option
is selected, an LXS channel is allocated. This channel can be viewed in the CHANINFO
schematic. The description of this channel is $TPN_COMM_RQST_SRVR and is limited
to 12 characters.

On clearing the HCI State Notification option, the LXS channel is de-allocated. The
start up of TPN Communication Service is dependant on the TPS Emulator Service.

The initial composite status (on resetting LCNP) of the HCI components is reflected in
the auxiliary status of the node after 2 minutes approximately. This delay allows the HCI
components to return to their steady/normal state.
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GUS GROUP DISPLAYS PAGE

7.1 Overview of the GUS Group Displays Page

The GUS Group Displays Page is used for configuring the GUS Group displays.

The GUS Alarm Summary is not supported on Experion nodes.

7.2 Accessing the GUS Group Displays Page

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure > GUS Group Displays.

RESULT: The following is displayed.
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7.3 Group Display

Check the Remove slot highlight on loss of focus box if you want an operator- selected tag in a GUS
Group Display to be deselected when its window no longer has focus.

Check the Group Display - Enabled box if you want GUS Group Displays to be invoked by keyboard
actions or GUS scripting interaction, instead of the standard Native Window Group displays.

If not blank, the Group Trend and Group Hour Avg identify the GUS display that will be invoked when
the IKB/OEP TREND or HOUR AVG is pressed while the GUS Group Display has focus. The invocation
will include the current Group Number as the DisplayParameter.

The Group Display is a standalone executable that still must be enabled if you wish to replace its Native
Window counterpart.
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7.4 Faceplate Keyboard Configuration

The Point Trend and Point Hour Avg identify the path of a GUS display that will be invoked when the
IKB/OEP TREND or HOUR AVG is pressed while the Faceplate.exe or a GUS Display has focus.

l The invocation includes the current point name as the DisplayParameter.

l If a faceplate has focus, its tagname will be the current point.

l If an AlarmWindow with a selected alarm has focus, that point will be the current point.

l Otherwise, the current point will be (in order of preference) the PMK entity, $CZ_ENTY or $AL_
ENTY.

Check the Use Cursor Keys and/or OEP Tab Keys as Ramp Keys if the node has an Honeywell Icon
Series Console Operator Entry Panel (OEP) and you want to allow the OEP tab keys to be used as ramp
keys.

Check the Resize Faceplate Exe to resize the faceplate.
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GUS DISPLAY RUNTIME SETTINGS PAGE

8.1 Overview of the GUS Display Runtime Settings

The GUS Display Runtime Settings Page is used for configuring a number of different GUS display
runtime parameters.

8.2 Configuring GUS Displays for Runtime

1. For ES-T nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility refer to section Starting the Configuration
UtilityStarting the Configuration Utility.

2. Select the following:

Configure > GUS Display Runtime Settings.

RESULT: The following page is displayed.
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35097.bmp

3. Enter the number of process into the GPB Process Pool Size data input port. Note that the GPB
Process Pool Size >= (max. # of concurrent displays) + (max. # of current display replacements).

Refer to the section GPB Process Pool Size in the GUS Remote Displays User's Guide for more
information on the Process Pool.

4. Click (check) the Set Foreground Configuration check box to enable scripts to transfer the focus to
another window when any user logs on.

5. Click (check) Numeric- Keypad * Handling check box to allow GUS faceplate/Group and GUS
change Zone to invoke the numeric- keypad * key to clear the data entry port (same as CLR ENTR
key in the OEP).

If you press the numeric- keypad * key without selecting Numeric- Keypad * Handling, the INVALID
ENTRY error message appears.

6. Click (check) the Not Validated Displays check box if you want to allow displays that are not
validated to run.

7. Enter a secondary search path for GUS displays into the Display Search Path Extension data input
port.

8. Enter the pathname to a new directory into the Save- As- Bitmap Default Directory data input port.

9. Click OK to complete the GUS Display Runtime configuration procedure.

8.2.1 Set Foreground Configuration

With Experion R400, remove all references 'to enablesetforeground.exe' from the node start-up scripts
or operator.bat file.

On Experion nodes, this behavior is enabled during the installation of the node.
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8.2.2 Numeric- Keypad * Handling

With GUS R350 and later, the numeric- keypad * key in the IKB and in the OEP can be used as a CLR
ENTR key to clear the entry ports in GUS faceplate/Group and GUS change Zone. This feature is similar
to the one available for the Native Window.

8.2.3 Display Search Path Extension

The primary area database search path for GUS displays (.pct files) is defined in the NCF. The system
software always uses this search path first to try to locate GUS display files.

Entering a search path to a Drive and Directory on your GUS into the Display Search Path Extension
data entry port provides another (secondary) area where GUS display files can be kept.

When this parameter is 'blank,' which is the default value, the system software will use only the primary
area database search path to try to locate GUS display files.

8.2.4 Not Validated Displays

After a GUS display is built, the normal, recommended procedure is to validate it before it is run. This
display validation function verifies that the data references in scripts and objects dynamics are correct
and binds references in the display to the data to allow successful and efficient access during display
execution. A display can run with validation errors, but runtime errors may occur if data cannot be
accessed during execution due to invalid data references.

Setting the Not Validated Displays checkbox allows invalidated displays to run and should be used
only for testing.

The default value for this checkbox is 'unchecked,' which means that all displays will be checked before
they are run to see if they have been validated. If an invalidated display is found, an error message will
be displayed.

8.2.5 Save- As- Bitmap Default Directory

The GUS Display Builder provides the File menu command 'Save View as Bitmap' which enables users
to save the current GUS display as a standard MS Windows bitmap file (.bmp, 24- bit TrueColor).

Entering a pathname into the Save- As- Bitmap Default Directory data entry port specifies where these
GUS display bitmap files are to be saved when the Save View as Bitmap command is executed.

When this parameter is 'blank' (the default value), GUS display bitmap files will be saved to the directory
where the GUS display file (.pct) is stored.

Here is an example of a valid pathname.
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GUS DISPLAY RUNTIME TIMERS PAGE

9.1 Overview of the GUS Display Runtime Timers Page

The GUS Display Runtime Timers Page is used for configuring values for a number of different timing
parameters associated with GUS displays.

9.2 Configuring GUS Display Runtime Timers

1. For ES-T and Experion APP nodes select;

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility.

2. Select the following:

Configure > GUS Display Limits.

RESULT: The following page will be displayed.
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35112.bmp

3. Enter the time (in msec) into the 'Shutdown Wait Limit' Timeout data input port.

4. Enter the time (in sec) into the 'Max Displays Reached' Dialog Delay data input port.

5. Enter the time (in msec) into the User- Event Synchronized Script Execution Limit data input port.

6. Enter the time (in msec) into the OnDataChange/OnPeriodicUpdate Script Execution Limit data
input port.

7. Enter the time (in msec) into the Cursor Over Target Response Time data input port.

8. Click OK to complete the GUS Display Limits configuration procedure.

9.2.1 Shutdown Wait Limit Timeout

The Shutdown Wait Limit applies to GUS displays that use the OnDisplayShutDown subroutine. It
should be used to allow displays enough time for pending scripts to run to completion but shut down if a
script gets into an extremely long or infinite loop.

Refer to the OnDisplayShutDown section in the Display Authoring Tutorial manual for additional
information.

When a GUS display is shutting down, pending scripts are allowed to run to completion. If a display
script gets into an infinite loop, the display may not be able to close. This will affect the ability to invoke
new GUS displays, which can cause a variety of problems.
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Entering a time into the 'Shutdown Wait Limit' Timeout data entry port will force all GUS displays to close
normally, avoiding the delay associated with an infinite or a potentially very long loop.

When this parameter is '0,' an 'infinite' timeout is assumed, and this means that GUS displays will never
be forced to terminate.
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GUS HCI CLIENT PAGE

10.1 Configuration Instructions

Refer to Timeouts in the HCI/OPC Data Access User's Guide for configuration information.
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GUS REMOTE DISPLAYS CLIENT PAGE

11.1 Reference to Other Documentation

For information on the GUS Remote Displays Client Page of the Configuration Utility, refer to the GUS
Remote Displays User's Guide.
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GUS REMOTE DISPLAYS SERVER PAGE

12.1 Reference to Related Documentation

For information on the GUS Remote Displays Server Page of the Configuration Utility, refer to the GUS
Remote Displays User's Guide.
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LCN I18N PAGE

13.1 Overview of LCN I18N Page

The LCN I18N Page is used for configuring the different language fonts used by the Native Window.

13.2 Accessing the LCN I18N Page

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure > LCN I18N.

RESULT: The following is displayed:
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13.3 Selecting Fonts

Typically, FullHeight Font Size is set to 16 points, and HalfHeight Font Size is set to 8. A smaller size
may have to be selected if the text does not fit within the box at run time. The default FullHeight and
HalfHeight fonts are 'lcn8x16.fon'and 'lcn8x8.fon'. They are installed in the following directory:

Program Files\Honeywell\TPS\NativeWindow\Fonts

LCNstd.ttf and LCNhalf.ttf are direct replacements for the lcn8x16_0.fon and lcn8x8_0.fon fonts. They
are usable with all screen resolutions and are the preferred font for screens set to 1024x768 or less. On
high resolution screens (1600x1200) the light weight of the font (necessary for clarity at 640x480)
makes parts of some characters appear dimmer than may be desired.

LCNhires.ttf and LCNhiresHalf.ttf are designed specifically for use on high resolution monitors (set at
1280x1024 or 1600x1200). These are heavier fonts with more curvatures than the LCNstd.ttf and
LCNHalf.ttf. As a result, the characters may appear to be ragged at some sizes on lower resolution
screens.

All of these fonts are monospace, sans serif. When used outside of the NativeWindow, a font size of 10
for LCNstd.ttf and LCNhires.ttf matches the character size of lcn8x16_0.fon, and a font size of 7 for
LCNhalf.ttf and LCNhiresHalf.ttf matches the character size of lcn8x8_0.fon. The LCN fonts include the
ASCII characters (0- 127) set plus the Kanji characters (encoded as 128- 191).
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CAUTION

The Native Window will not be able to display text if you select a language and the selected fonts
do not support the language.

13.4 Increasing the Font Size in the Native Window

To properly increase the font size of the Native Window, use the procedure described in the section
Increasing the Font Size for the Native Window/ in the TPS System Implementation Guide.
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SIGNON MANAGER PAGE

14.1 Overview of Signon Manager Page

This page is used for configuring the Signon Manager.

The Signon Manager is used for tracking which user is logged on to a node and to allow Honeywell
applications to validate that users have permission to perform certain operations.

For detailed instructions to configure Signon Manager, refer to the section Configuring Signon
Manager in the TPS System Implementation Guide.

For information of how to use Signon Manager, refer to the section Interfacing with Signon Manager in
the TPS System Operations Guide.

14.2 Accessing the Signon Manager Page

1. For ES-T and Experion APP nodes select:

Choose Start > All Programs > Honeywell Experion PKS > System Management > Configuration
Utility.

Or,

From the System Management Display, right-click the node of interest.

For detailed instructions to start the Configuration Utility, refer to section Starting the Configuration
Utility

2. Select the following:

Configure > Signon Manager.

RESULT: The following is displayed.
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The TPS KeyLevel is available for GUS and with limited functionality for Experion Station - TPS.
See KEYLEVEL Access in the Integrated Experion-TPS User's Guide for more information.

14.3 Signon Manager Options

Options Tab

Behavior -
Auto hide
(default=on)

When this option is on, the Signon Manager window is hidden with only a thin strip
visible. Signon Manager can be invoked by moving the mouse pointer over the thin
strip. When this option is off, a small window indicating the currently signed on user
remains on- screen at all times, unless covered by a higher priority window.

Signon
Display
Colors
(default =
blue text on
light blue
background)

This option allows the user to make the 'current user' window either more or less
obvious, depending on site preference. The following options are provided to change
the colors of the window:

1. Select Windows dialog colors

2. Select Windows taskbar colors

3. Select the Text and/or Background buttons. Each button displays the standard
Windows color selection dialog box.

KeyLevel Tab

Trust keylevel
changes from
IKB (default=

When this option is on, LCN keylevel changes originating from a physical keyswitch
are used, even if the currently signed on user is not authorized at this level. For sites
not using the physical keyswitch, this option is not used. For sites that do use the
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on) physical keyswitch, this option allows a quick keylevel change without the delay of
entering a user id and password.

Treat
physical key
OPR position
as ViewOnly
(default= off)

The Treat physical key OPR position as ViewOnly checkbox determines whether GUS
displays will respond to a change when the IKB key is switched to OPR or VIEW. For
the Native Window, this behavior is controlled by the NCF.

Automatically
raise keylevel
to maximum
allowed for
SignOn user
(default = off)

When this option is on, TPS applications that are Signon Manager- aware (Native
Window and GUS displays) automatically raise the LCN keylevel for a new signon to
the highest keylevel allowed for the new user. When this option is not set, TPS
applications will not automatically raise the keylevel for a new signon, but will always
lower the key setting if the new user is not authorized at the current level.

Default
Workstation
Keylock
(default =
View Only)

This option allows a site to decide what the default keylevel will be for a workstation.
This default keylevel is set whenever a Windows login or logout occurs. The default
provides the starting point for the key setting for a workstation at the time a user logs
onto the machine. If the auto- raise option above is enabled, this setting is of little
concern.

Timeouts Tab

Sign users off
if there is no
activity
(default= off)

When this option is on, the users are signed off if the period of inactivity exceeds the
configured limit.

Sign override
users off
(default= off)

When this option is on, the override users are signed off if the period of inactivity
exceeds the configured limit. Select the option User may select the timeout of up to
option to specify a limit for user selectable timeout.

Timeout
Warning

The following configurable options are available for timeout warning. A warning is
raised before the configured number of seconds before actually signing off a timed
out user. Select Show user interface if hidden to display the user interface if it is
hidden at the time of warning. Select the Play sound to configure a sound file that
needs to be played during a timeout warning.

ID Reader Settings

Select device
type

Selecting the card reader from the drop-down list attempts to attach the card reader to
Signon Manager. If '<none>' is selected, the card reader is detached from the Signon
Manager.

Select port

Re-signon
interval
(seconds)

If the same card is used for signing in again within the specified interval, the system
does not prompt for sign in. The range of this interval is 0 to 300 seconds.

Disable
interactive
signon while
user
identification
device is
active

When this option is selected, the Signon Manager does not allow manual signon
while a device is present. When this option is not selected, the Signon Manager
allows manual signon whether device is present or not.

Ctrl + Alt
enables
override

When this option is selected, If the ctrl and alt keys are pressed together at the time of
badge entry and if there is a current signon, the new signon is treated as an override.
When this option is not selected, All signon events replace any prior signon (no
override except manual entry).
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Sign off when
card is
removed

When this option is selected, the Signon Manager is automatically signed off when a
card is removed. When this option is not selected, signoff is manual (GUI button) or by
timeout only.

Allow user to
manually
complete
failed card
signon

When this option is selected, if the signon based on the credentials from the card
does not succeed, the user is allowed to enter a password. This allows use of a card
after the user's password is changed if the card has not been updated yet when this
option is not selected, if the signon based on credentials from the card does not
succeed, the signon attempt fails.

Allow user
self-
registration

When the option is selected, If the smart card does not contain any credentials, the
user is prompted for user id, password, and possibly PIN. Those credentials are used
for attempting a signon. If the signon succeeds, the credentials are written to the smart
card if it is still in the reader. 'Allow user to manually complete failed card signon' is
always selected when this option is selected. When this option is not selected, Based
on 'Allow user to manually complete failed card signon', signon may or may not be
completed, and credentials are not saved. Note: If this option is selected, the 'Allow
user to manually complete failed card signon' option is automatically selected.

Allow user
update to
credentials

When this option is selected,
l If the card contains credentials which do not successfully sign in, and

l the user subsequently provides credentials that successfully signs in, the
credentials on the card are updated.

'Allow user to manually complete failed card signon' is always selected when this
option is selected. When this option is not selected, Based on 'Allow user to manually
complete failed card signon', signon may or may not be completed, but credentials
are not saved. Note: if this option is selected, the 'Allow user to manually complete
failed card signon' option is automatically selected.

Extended
validation

l None - no manual entry is required

l Require password - the credentials password is ignored and the user is
prompted for a password

l Require PIN - the credentials on the card must include a non-empty PIN which
must match the PIN the user is prompted for

l Require PIN and password - combination of the prior two options
Notes:

l If the PIN option is not selected, any PIN registered on the card is ignored and
not required at signon.

l If the PIN option is selected, and the card used does not have a registered PIN,
the signon fails, even if the PIN in the validation dialog is left blank.

l When prompted for both PIN and password, they are entered into a single dialog
(that is, there will not be multiple prompts).
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HCI COMPONENTS PAGE

15.1 Reference to Additional Documentation

For more information on the HCI Components Page of the Configuration Utility, refer to the System
Management Configuration Guide.
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HCI NAME SERVICE PAGE

16.1 Reference to Additional Information

For more information on the HCI Name Service page of the Configuration Utility, refer to the System
Management Configuration Guide.
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NOTICES

Trademarks
Experion®, PlantScape®, SafeBrowse®, TotalPlant®, and TDC 3000® are registered trademarks of
Honeywell International, Inc.

ControlEdge™ is a trademark of Honeywell International, Inc.

OneWireless™ is a trademark of Honeywell International, Inc.

Matrikon® and MatrikonOPC™ are trademarks of Matrikon International. Matrikon International is a
business unit of Honeywell International, Inc.

Movilizer® is a registered trademark of Movilizer GmbH. Movilizer GmbH is a business unit of
Honeywell International, Inc.

Other trademarks
Microsoft and SQL Server are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Other brands or trademarks are trademarks of their respective owners.

Trademarks that appear in this document are used only to the benefit of the trademark owner, with no
intention of trademark infringement.

Third-party licenses
This product may contain or be derived from materials, including software, of third parties. The third
party materials may be subject to licenses, notices, restrictions and obligations imposed by the licensor.
The licenses, notices, restrictions and obligations, if any, may be found in the materials accompanying
the product, in the documents or files accompanying such third party materials, in a file named third_
party_licenses on the media containing the product.

Documentation feedback
You can find the most up-to-date documents on the Honeywell Process Solutions Support website at:
http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions documentation, send your feedback to:
hpsdocs@honeywell.com

Use this email address to provide feedback, or to report errors and omissions in the documentation. For
immediate help with a technical problem, contact HPS Technical Support through your local Customer
Contact Center, or by raising a support request on the Honeywell Process Solutions Support website.

How to report a security vulnerability
For the purpose of submission, a security vulnerability is defined as a software defect or weakness that
can be exploited to reduce the operational or security capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting Honeywell products and services.

To report a potential security vulnerability against any Honeywell product, please follow the instructions
at:

https://www.honeywell.com/en-us/product-security.

Support
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For support, contact your local Honeywell Process Solutions Customer Contact Center (CCC). To find
your local CCC visit the website, https://www.honeywellprocess.com/en-US/contact-us/customer-
support-contacts/Pages/default.aspx.

Training classes
Honeywell holds technical training classes that are taught by process control systems experts. For more
information about these classes, contact your Honeywell representative, or see
http://www.automationcollege.com.
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